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CE Mark

The CE marking applied to this product symbolises Rank Xerox’s declaration of conformity with the following applicable directives of the European Union as of 
the dates indicated.

January 1, 1996—Council Directive 70/80/CCO amended by Council Directive 93/68/EEO. Approximation of the laws of the member states related to low 
voltage equipment.

January 1, 1996—Council Directive 59/336/EEC. Approximation of the laws of the member states related to electromagnetic compatibility.

A full declaration defining the relevant directives and referenced standards can be obtained from your Rank Xerox representative.

WARNING: In order to allow this equipment to operate in proximity to industrial, scientific, and Medical (ISM) equipment, the external radiation from 
ISM equipment may have to be limited or special migration measures taken.

WARNING: This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to 
take adequate measures.

FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, 
and uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause interference in which case the user will be required to correct the interference 
at his own expense. 

Industry Canada Class A Notice

This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus as set out in the interference-causing equipment standard 
entitled, “Digital Apparatus” ICES-003 from Industry Canada.

Avis de Conformation Classe A d l’Industrie Canada 

Le présent appareil numérique n’émet pas de bruits radioélectriques dépassant les limites applicables aux appareils numériques de la Classe A prescrites dans la 
norme sur le matériel brouilleur, “Appareils Numériques” NMB-003 édictée par l’Industrie Canada.

Certificate by Manufacturer/Importer

This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been 
advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.
Electronics for Imaging, Inc.

Bescheinigung des Herstellers/Importeurs

Heirmit wird bescheinigt, dass der FC07 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstort ist. Der Deutschen Bundespost wurde 
das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.
Electronics for Imaging, Inc.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen 
geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten 
werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.



             
Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen ist 
der Betreiber verantwortlich.

Software License Agreement

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 
with the DocuColor Color Server you have purchased, including without limitation the PostScript® software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with DocuColor;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with DocuColor in a special encrypted format (“Coded 
Font Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your own 
customary business purposes on the screen of the DocuColor or Macintosh monitor used with DocuColor;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to DocuColor provided the transferee agrees to be bound by 
all of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces 
for use other than with DocuColor;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 
necessary for use with the DocuColor unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made, 
any copies of that certain portion of the Software which has been included on the DocuColor hard disk drive. You may not copy the documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging 
and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this 
Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or 
licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or 
trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces 
the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font Programs. 
At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

The MacApp software is proprietary to Apple Computer, Inc. and is licensed to Electronics for Imaging, Inc. for distribution only for use in combination with 
DocuColor software utilities.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 
to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 
termination of this license and will make available to Electronics for Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 
significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 
DocuColor to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt to 
correct or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some 
states do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.



           
Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or 
statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 
OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 
OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that 
the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 
THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF DOCUCOLOR XJ REFLECTS THIS ALLOCATION 
OF RISK. BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 
licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 
Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Ave., San Jose, CA  95110 (“Adobe”) is a third-party 
beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the Typefaces 
and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics for 
Imaging.

General

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 
Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site 
at www.efi.com.

Electronics for Imaging, Inc.
2855 Campus Drive
San Mateo, CA 94403
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xi How the DocuColor works

         
The DocuColor Color Server enables you to use your color copier as a networked 
printer. You can use the DocuColor to print final documents or to proof jobs you will 
later print on an offset press. You can print to the DocuColor as you would print to a 
LaserWriter or other printer—you select it from the Macintosh Chooser or Windows 
Printers dialog box, and then print from within any application.

You can print to the DocuColor from networked Macintosh computers, from 
networked Windows-based computers running Microsoft Windows, and from 
networked UNIX workstations running TCP/IP. In addition, you can use the parallel 
port to print directly from a Windows computer.

How the DocuColor works
The DocuColor is a special-purpose controller that enables you to use a color copier as 
a printer by connecting it to networked computers. The DocuColor receives files from 
computers on your network, processes (RIPs) those files, and then sends them to the 
copier’s print engine for printing. Even with the DocuColor installed, you can still use 
your copier to make copies.

Macintosh and Windows computers communicate with the DocuColor by means of a 
Printer Driver application. Printer description files enable you to use special features of 
the DocuColor from the Print dialog box.

About the documentation
This guide is part of the set of DocuColor documentation that also includes the 
following manuals for users and system administrators:

• Getting Started describes how to install the software from the User Software CD or 
from floppy disks and how to set up printing.

• The Administrator Guide explains basic configuration and administration of the 
DocuColor for the supported platforms and network environments. It also includes 
guidelines for setting up UNIX, Windows NT, and NetWare servers to provide 
PostScript printing services to clients.

Before You 
Begin



 

xii Before You Begin

       
• Release Notes include information about changes in the current release of system and 
user software, last-minute information, and information to help you use them 
efficiently.

Using this manual
This manual includes the following topics:

• Printing from a Macintosh computer

• Printing from a Windows computer

• Printing from UNIX

• Using the Spooler and Downloader utilities, and the WebSpooler WebTool

The Spooler and Downloader utilities are supported from Windows 95 and 
Windows NT 4.0 only; they are not supported from Windows 3.1x, 
Windows NT 3.51, or Macintosh computers.

• Appendixes—Includes a list of DocuColor error messages, a list of the printer fonts 
installed on the DocuColor, troubleshooting information, and information about 
setting and overriding print options.

Safety warnings
The DocuColor display window is a liquid crystal display (LCD) that is made of glass 
and can break. Do not subject it to strong shocks.

If the display window breaks and the liquid crystal material leaks out, do not inhale, 
ingest, or touch it. If the material gets on your skin or clothing, wash it off with soap 
and water immediately.

Do not touch or put pressure on the panel. This will change the color of the panel.



 

xiii Specifications

        
Cleaning the DocuColor
Clean the DocuColor with a soft cloth moistened with isopropyl alcohol or ethyl 
alcohol. Never use water or ketone as these may permanently alter the display.

Specifications
The DocuColor has the following features:

• CPU R4700, 150MHz

• 32MB RAM

• Internal 2.1 GB hard disk drive

• Supports TCP/IP and IPX/SPX protocols simultaneously

• Supports EtherTalk

• Supports thinnet (thin coaxial Ethernet cable or 10Base2), thicknet (thick coaxial 
Ethernet cable or 10Base5), and unshielded twisted pair (Ethernet 10BaseT or 
Fast Ethernet 100BaseTX with additional optional hardware)

• Supports token ring networking with additional optional hardware

• Supports Adobe PostScript 3

• Includes 136 fonts (117 Adobe Type 1 PostScript and 19 TrueType)

In addition, two Adobe Multiple Master fonts are included and are used for font 
substitution in PDF files.

You can use Downloader or any third-party LaserWriter downloader, such as the 
Adobe Font Downloader, to download additional fonts.

• Built-in ColorWise® color management

• AutoCal

• Spooler and Downloader utilities

• WebTools
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Supported paper sizes
The DocuColor supports printing at 400dpi (dots per inch) on the following paper 
sizes:

• Postcard (4" x 6")

• Letter, Letter-R (8.5" x 11")

• Legal (8.5" x 14")

• Tabloid (11" x 17")

• A6 (105mm x 148mm)

• A4, A4-R (210mm x 297mm)

• A3 (297mm x 420mm)
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1-1 Using the Control Panel

     
You can use the DocuColor control panel to view status information about jobs, print 
special pages, and set up printing. For information about Setup options and how to use 
them, see the Administrator Guide.

Using the Control Panel
The Control Panel on the front of the DocuColor enables you to access special features 
and view information about jobs printed to the DocuColor. 

It comprises the following parts:

• Activity light that indicates current DocuColor activity

• Line selection buttons

• Up and down arrow buttons

• Menu button

• Display window showing status information and options for setting up the 
DocuColor

Chapter 1:
Operating the 
DocuColor

Activity light 

Menu button

Display window

Up and down arrow buttons

Line selection buttons
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1-2 Operating the DocuColor

      
Activity light
The activity light indicates the current DocuColor activity. If the light is:

Buttons

Solid red There is an error causing printing and scanning to be 
disabled, and the DocuColor is idle.

Flashing red There is an error causing printing and scanning to be 
disabled, but the DocuColor is still processing. The light 
changes to solid red when it is finished processing.

Solid green The DocuColor is idle.

Flashing green The DocuColor is processing or printing a job, or 
communicating with a remote computer—for example, 
through the Spooler.

No light The DocuColor is off or starting up.

Line selection 
buttons

There are four line selection buttons on the right side of the 
Control Panel. Use these buttons to select the command 
displayed on the corresponding line of the display window. A 
special character (>) appears in the display window next to a 
button when it is active.

Up/down arrow 
buttons

Use these buttons to scroll to different screens in 
multi-screen lists, to select Setup options from a list of 
available options, and to select alphanumeric characters. 

Menu button Press this button to view other screens. Under normal 
operation, the Control Panel displays the Info Status screen 
with information about the status of the DocuColor. If you 
press the Menu button, the Functions menu is displayed and 
you can perform additional operations. If a job is processing 
or printing, press the Menu button to display the RIP Status 
screen or Print Status screen.
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1-3 Using the Control Panel

        
Display window
The display window provides information about the status of the DocuColor, displays 
menu information, and enables you to view and edit information in the Setup menus. 

The last line of the display window displays text that tells you what screen you are 
looking at and highlights one of the icons to indicate what the DocuColor is doing. 
Only the icons for the screens that are currently available appear.

The screens are:

Alert Status If there is a problem with processing a job or printing functions, 
an error message appears on the Control Panel. For information 
on error messages, see Appendix A “Error Messages.” 

Print Status When the DocuColor is printing or scanning a job, the Print 
Status screen appears. This screen displays the following:

Cancel Job—Press the top line selection button to cancel the job 
currently printing. 

User name—The name of the user who sent the job currently 
processing.

Pages/Total—The number of copies of the current page printed 
and the total number of copies of the page requested.
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1-4 Operating the DocuColor

                 
RIP Status When the DocuColor is processing a job, the RIP Status screen 
appears. This screen displays the following:

Cancel Job—Press the top line selection button to cancel the job 
currently processing. The DocuColor cancels the job before 
printing begins.

Document name—The name of the document currently 
processing.

User name—The name of the user who sent the job currently 
processing.

Kilobytes—The amount (in kilobytes) of the job processed so 
far.

Info Status When the DocuColor is not processing or printing a job, it 
displays information about the current server and software. It 
displays the following information:

Server Name—The DocuColor name.

Status—The current status of the DocuColor. The DocuColor 
status can be: Idle, Initializing, Busy, Processing, Printing, or 
Scanning.

Number of MB—The space (in megabytes) available on the 
DocuColor hard disk.

Version—The system software version running on the 
DocuColor.

Functions You can press the Menu button to display the Functions menu. 
Use the up and down arrow buttons to scroll through the list. 
Press the line selection button to the right of the command to 
select it. 
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1-5 Using the Control Panel

                     
Functions menu

You can choose the following commands from this menu:

Choose: To do this:

Print Pages Print special pages from the DocuColor. You can print the 
following pages from the submenu that appears:

Test Page—A test page enables you to confirm that the 
DocuColor is properly connected to the copier and 
provides color and grayscale samples to troubleshoot 
problems with the copier or the DocuColor. The 
following information is listed: Server Name, Printer 
Model, and Date and Time printed.

Configuration—Prints the Configuration page, which 
gives the current server and device configuration. This 
page lists general information about the hardware and 
software configuration of the DocuColor, the current 
options for all Setup settings, and the ethernet and token 
ring addresses (if applicable) of the DocuColor.

Job Log—Prints a log of the last 55 jobs. For information 
on the fields in the Job Log and on printing it in other 
forms, see “Using the Job Log” on page 5-9.

Control Panel Map—Prints the Control Panel map, which 
is an overview of the screens you can access from the 
Control Panel. For information about using these screens 
to set up the DocuColor, see the Administrator Guide.

Font List—Prints a list of all fonts resident on the hard 
disk.

Suspend Printing Suspend communication between the DocuColor and the 
copier. You can suspend printing if you want to interrupt 
the current DocuColor job so that you can use the copier 
to make copies. Jobs continue to process on the 
DocuColor and after you make the copies, you can select 
Resume Printing and the copier will continue printing 
jobs. 
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1-6 Operating the DocuColor

            
Starting and shutting down the DocuColor
Generally, you can leave the DocuColor running all the time. This section describes 
how to shut down and restart the DocuColor when necessary.

Starting the DocuColor
To start the DocuColor, move the switch on the rear of the DocuColor to the On 
position.

Diagnostic messages appear on the Control Panel. If any diagnostics fail, more 
information and instructions appear. Contact your service representative if the 
DocuColor encounters problems while running the diagnostics.

Resume Printing Resume communication between the copier and the 
DocuColor after you have finished making copies. 

Run Diagnostics This command is provided for service representatives. Use 
the line selection buttons to select the diagnostic test you 
want to run and choose OK. Contact your authorized 
service/support technician for information about these 
diagnostics.

Reboot Server Shut down all DocuColor activity in the correct manner 
and then restart. You should use this option instead of the 
switch on the rear of the DocuColor.

Power switch in the 
off position
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1-7 Starting and shutting down the DocuColor

       
When the diagnostics are finished, the following message is displayed:

For software update or setup press any key

If you want to change the Setup options, press one of the buttons; if you do not press a 
button, the DocuColor continues starting up and displays the message Idle when it is 
ready to receive data.

If you press a button, the following options appear:

Restarting the DocuColor
You should use the procedure described in this section to restart the DocuColor rather 
than using the power switch on the rear of the DocuColor. 

TO RESTART THE DOCUCOLOR:

1. Make sure that the DocuColor is not receiving, processing, or printing a document. 

Make sure that the status message on the Control Panel is Idle.

NOTE: If a job from the Print Queue is processing, it will continue processing and print 
after the DocuColor is restarted; if a job sent to the direct connection is processing, it 
will not finish processing or printing.

2. Press the Menu button to display the Functions menu.

3. Use the down arrow button to scroll to the last screen and choose Reboot Server.

Choose: To do this:

Run Setup View the options in the Setup menus. For information on 
these settings, see the Administrator Guide.

Install Software Install new system software. This should be done only by 
your DocuColor service representative.

Format Disk Reformat the DocuColor hard disk. This should be done 
only by your DocuColor service representative.
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Shutting down the DocuColor
You may need to shut down the DocuColor for service. When you do so, fonts that 
have been downloaded to the hard disk drive are not deleted. Print jobs in the Hold 
and Printed queues and jobs that have been processed but not printed are not deleted 
and are available for printing when you restart the DocuColor.

TO SHUT DOWN THE DOCUCOLOR:

1. Make sure that the DocuColor is not receiving, processing, or printing a document. 

Make sure that the status message on the Control Panel is Idle.

NOTE: If a job from the Print Queue is processing, it will continue processing and print 
after the DocuColor is restarted; if a job to the direct connection is processing, it will 
not finish processing or printing.

2. Press the Menu button to display the Functions menu.

3. Scroll to the final screen and select Reboot Server.

You should always select Reboot Server before you turn the DocuColor off to ensure 
that no jobs are lost.

4. Switch off the DocuColor when it restarts.
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You can print to the DocuColor just as you would print to any other printer from any 
application software. First, select the DocuColor as the current printer in the Chooser, 
and then print the file from within your application.

Jobs printed to the DocuColor are sent from your Macintosh computer to a network 
server via AppleTalk; the network server then prints the job to the DocuColor via 
IPX/SPX. For more information on setting up network servers to communicate with 
the DocuColor, see the Administrator Guide.

Printing from applications
Before you can print to the DocuColor from applications, you must select the 
DocuColor in the Chooser. Then, using the Adobe PostScript printer driver and the 
correct PostScript Printer Description (PPD) file, you can control many DocuColor 
printing features by specifying job settings from print dialog boxes. 

Selecting the DocuColor in the Chooser
Before you print a job, make sure the DocuColor is the currently selected printer.

TO SELECT THE DOCUCOLOR AS THE CURRENT PRINTER:

1. Make sure the DocuColor is turned on, is connected to the network via a Novell server.

For instructions, see the Administrator Guide.

2. Choose Chooser from the Apple menu.

3. Click the AdobePS icon to select it.

4. If your network is divided into zones, select the zone in which the DocuColor is 
located.

5. Select the DocuColor in the list of printers that appears.

The names of all supported printers in the zone appear in the scroll list on the right. 
The DocuColor appears with its shared printer name (the Spooler’s AppleTalk Name, 
as set on the Novell server by your system administrator). For details, see the 
Administrator Guide.

Chapter 2:
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6. In the Chooser window, make sure that AppleTalk is Active and then click the close box 
to quit the Chooser.

The DocuColor remains selected as the current printer until you choose a new printer 
in the Chooser.

Setting print options
With Macintosh computer applications, print options are set from both the Page Setup 
dialog box and the Printer Specific Options dialog box. For details, see Appendix D, 
“Setting Job Overrides.”

NOTE: Some default print options are set by the administrator during Setup. Check 
with the administrator for information on the current server default settings.

TO PRINT FROM A MACINTOSH APPLICATION USING THE 
ADOBEPS PRINTER DRIVER:

1. Open the file you want to print from within the application.

2. Choose Print from the application’s File menu.

The Print dialog box appears.

NOTE: Print dialog boxes vary across applications.

If the Print dialog box lets you select from a pop-up menu of available printers, choose 
the DocuColor.
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In the Paper Source pop-up menu, specify the paper tray to use for the job. For 
example, you can specify that the job should be printed on pages in the Bypass tray. 
Tray selection is valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the DocuColor displays an error message and 
the job will not print. You should then load the correct paper in the selected tray or 
cancel the job.

3. From the General pop-up menu, choose Notes.

In the Notes 1 and Notes 2 areas, enter user and job identification information for 
accounting purposes, or whatever information is required at your site. The notes you 
enter in these areas appear in the Job Log.

4. From the Notes pop-up menu, choose Printer Specific Options.

5. Select the appropriate settings for your print job.

These print options are specific to the DocuColor. They override settings in Printer 
Setup on the DocuColor Control Panel; you can also override some of these settings in 
the WebSpooler or in the Spooler Override Print Settings dialog box. For information 
about these options and overrides, see Appendix D, “Setting Job Overrides.”
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If you choose Printer’s default, the DocuColor prints with either the default value for 
the server, or the information entered during Setup on the DocuColor Control Panel.

Some PPD options can also be set from within an application. In these cases, use the 
DocuColor PPD option to perform the function, rather than setting it from the 
application. (The application may not set up the file properly for printing on the 
DocuColor and may also take longer to process.)

6. If you want to make the new settings your default settings, click Save Settings.

7. Click Print to begin printing your job.
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The DocuColor enables you to print from a Windows-based computer connected to 
the DocuColor. This chapter describes how to print to the DocuColor from 
Windows 95®, Windows® 3.1x, and Windows NT™.

You can print from a networked Windows computer, or from a Windows computer 
connected to the parallel port on the DocuColor. If you plan to print files at another 
location, you should follow the procedures described in “Saving files to print at a 
remote location” on page 3-12.

Another way to print from a Windows computer is to download PostScript files or 
Encapsulated PostScript (EPS) files using the Downloader utility.

NOTE: For information on setting up the Windows environment for printing with 
Windows servers connected to the DocuColor, see the Administrator Guide. For 
information on how to connect to the DocuColor over the network, install printer 
drivers, and install the utilities, see Getting Started.

Printing from applications
Once you have installed the DocuColor printer driver and set it to the proper port as 
described in Getting Started, you should be able to print directly from most Windows 
applications. Simply choose the Print command from within your application.

Setting options and printing with Windows 95
Once you have installed the DocuColor printer driver file, you can select the printer 
settings you prefer. You can also change settings for a particular file when you print the 
file to the DocuColor. 

To print from Windows 95, use the Adobe PostScript printer driver included with the 
user software. This driver uses all features of the DocuColor.

Before printing, make sure that the correct print options are set.
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TO SET PRINT OPTIONS AND PRINT WITH THE ADOBEPS PRINTER DRIVER 
FROM WINDOWS 95:

1. Double-click the My Computer icon.

2. Double-click the Printers icon.

3. Select the icon for the DocuColor and choose Properties from the File menu.

4. Click the Paper tab.

5. Select the appropriate settings for your print job.

In the Paper Source pop-up menu, specify the paper tray to use for the job. For 
example, you can specify that the job should be printed on pages in the Bypass tray. 
Tray selection is valid for the current job only.
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NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the DocuColor displays an error message and 
the job will not print. You should then load the correct paper in the selected tray or 
cancel the job.

6. To select a specific media type, click More Options.

7. In the Paper type pop-up menu, specify the type of media to use for the job and click 
OK.
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8. Click the Options tab.

9. Click through the Job, Color, and Finishing tabs, and select the appropriate settings 
for your print job.

These print options are specific to the DocuColor. They override settings in Printer 
Setup on the DocuColor Control Panel; you can also override some of these settings in 
the WebSpooler or Spooler Override Print Settings dialog box. For information about 
these options and overrides, see Appendix D, “Setting Job Overrides.”

If you choose Printer’s default, the DocuColor prints with either the default value for 
the server, or the information entered during Setup on the DocuColor Control Panel.

10. If you want to make the new settings your default settings, click Apply.

11. Click OK to activate the current settings.
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12. From your application, choose Print.

The Printer Job Notes dialog box appears.

13. Enter text messages in the Notes 1 and Notes 2 areas. 

In the Notes 1 and Notes 2 areas, enter user and job identification information for 
accounting purposes, or whatever information is required at your site. 

The notes you enter in these areas appear in the Job Log.

The notes you enter in the Notes 1 and Notes 2 areas are kept in memory and appear 
automatically in this dialog box when you print subsequent jobs. You can edit these 
notes if necessary for subsequent jobs.

14. If you are printing from a Microsoft Office application, click Enable PostScript Level 2: 
for MS Office Only. 

As a rule, the Color Rendering Dictionaries (CRDs) are not used when printing from 
PostScript 1 applications. However, for the Microsoft Office 95 and Microsoft 
Office 97 suites of applications, you can enable CRDs with this setting.

15. Click OK to begin printing.
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Saving and loading print option settings

Print option settings can be saved to a file on your hard disk. Saving a settings file 
enables you to easily load specifically configured settings for a particular job.

TO SAVE PRINT OPTION SETTINGS:

1. After configuring the options from the Job, Color, and Finishing tabs, click 
Save Settings.

2. Name the settings file and browse to a location on your hard disk where you want to 
save the file.

3. Click OK.

The settings file is saved to the location you specified.

TO LOAD PRINT OPTION SETTINGS:

1. From the Options tab, Click Load Settings.

2. Browse to the settings file.

3. Select the settings file from the list and Click OK.

The options from the Job, Color, and Finishing tabs are automatically configured with 
the saved settings.

Setting options and printing with Windows 3.1x
Once you have installed the DocuColor printer driver file, you can select the printer 
settings you prefer. You can also change settings for a particular file when you print the 
file to the DocuColor. 

To print from Windows 3.1x, use the Adobe PostScript printer driver included with 
the user software. This driver uses all features of the DocuColor.

Before printing, make sure that the correct print options are set.
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TO SET PRINT OPTIONS AND PRINT WITH THE ADOBEPS PRINTER DRIVER 
FROM WINDOWS 3.1X:

1. In the Main window, double-click the Control Panel icon.

2. Double-click the Printers icon.

3. In the Printers dialog box, select the DocuColor in the Installed Printers box and click 
the Setup button.

4. Click the Paper tab.

5. Select appropriate settings for your print job.

In the Paper Source pop-up menu, specify the paper tray to use for the job. For 
example, you can specify that the job should be printed on pages in the Bypass tray. 
Tray selection is valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the DocuColor displays an error message and 
the job will not print. You should then load the correct paper in the selected tray or 
cancel the job.
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6. Click the Features tab.

7. Select the appropriate settings for your job and click OK.

These print options are specific to the DocuColor (you must scroll to see all the pop-
up menus). They override settings in Setup on the DocuColor Control Panel; you can 
also override some of these settings in the WebSpooler or Spooler Override Print 
Settings dialog box. For information about these options and overrides, see 
Appendix D, “Setting Job Overrides.”

If you choose Printer’s default, the DocuColor prints with either the default value for 
the server, or the information entered during Setup on the DocuColor Control Panel.
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8. Choose Print in your application. 

The Color Printer Job Notes dialog box appears.

9. If necessary, enter your name in the User and Document areas.

Once you enter your name in the User area, it appears automatically in this dialog box 
when you print subsequent jobs. 

NOTE: This entry cannot be changed without deleting and reinstalling the printer.

10. Enter text messages in the Notes 1 and Notes 2 areas. 

In the Notes 1 and Notes 2 areas, enter user and job identification information for 
accounting purposes, or whatever information is required at your site. 

The notes you enter in these areas appear in the Job Log.

The notes you enter in the Notes 1 and Notes 2 areas are kept in memory and appear 
automatically in this dialog box when you print subsequent jobs. You can edit these 
notes if necessary for subsequent jobs.

11. Click OK to begin printing.
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Printing with Windows NT 4.0
You can print from Windows NT 4.0 using the printer driver included with 
Windows NT. The Windows NT 4.0 PostScript printer driver supports many 
DocuColor-specific options.

TO SET PRINT OPTIONS AND PRINT WITH THE MICROSOFT POSTSCRIPT 
PRINTER DRIVER FROM WINDOWS NT 4.0:

1. Choose Print in your application and click Properties.

2. Click the Advanced tab.

3. Select the appropriate settings for your print job.

In the Paper Source menu, specify the paper tray to use for the job. For example, you 
can specify that the job should be printed on pages in the Bypass tray. Tray selection is 
valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 
type than that of the job you are sending, the DocuColor displays an error message and 
the job will not print. You should then load the correct paper in the selected tray or 
cancel the job.
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4. Scroll down to the print options, and select the appropriate settings for your print job.

These print options are specific to the DocuColor (you must scroll to see all the 
options). They override settings in Printer Setup on the DocuColor Control Panel; you 
can also override some of these settings in the WebSpooler or Spooler Override Print 
Settings dialog box. For information about these options and overrides, see 
Appendix D, “Setting Job Overrides.”

If you choose Printer’s default, the DocuColor prints with either the default value for 
the server, or the information entered during Setup on the DocuColor Control Panel.

5. Click OK, then click OK in the Print dialog box to begin printing.
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Printing with Windows NT 3.51
You can print from Windows NT 3.51 using the printer driver included with 
Windows NT. However, this driver does not support DocuColor-specific options. See 
Getting Started for information on the Windows NT PostScript printer driver.

Printing to the parallel port
The DocuColor has a parallel port that enables you to print most files directly from a 
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Using Downloader to print
Downloading files with Downloader is generally faster than printing from application 
software. You can use Downloader to print PostScript files or EPS files.

TO PRINT USING DOWNLOADER:

1. Create a PostScript file or EPS file. Specify the appropriate print options and include 
(embed) any necessary fonts that are not resident on the DocuColor.

For information on the fonts resident on the server, check with the administrator.

2. Start up Downloader and connect to the DocuColor.

3. Select the file(s) you want to download, and specify any necessary options.

4. Click Download.

For details, see “Downloading files and fonts” on page 5-11.
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You can print to the DocuColor directly from UNIX. Jobs printed to the DocuColor 
are sent to the Print queue and can be manipulated from Macintosh and Windows 
computers on the network.

The queue name and DocuColor printer name are established by your system 
administrator. Contact your system administrator for the name of your queues.

NOTE FOR ADMINISTRATORS:The internal rp name that must be matched exactly when 
setting up printing to the DocuColor is: print.

For information about setting up printing from TCP/IP, see your UNIX system 
documentation.

Printing to the DocuColor
You can use UNIX commands to print PostScript files and text files to the DocuColor. 
In general, the basic printing commands (lpr, lpq, lprm) can be used to send print jobs 
to a DocuColor. See your UNIX manual pages or other documentation for 
information about UNIX commands.

NOTE: Make sure that the files are either PostScript or text files. These are the only 
formats you can use to print from UNIX. 

TO PRINT FROM UNIX:

• On a system running SunOS4 or another BSD-based variant, use the lpr command to 
send a job to the DocuColor as follows:

lpr <-Pprinter> <-#copies> <filename>

For example, if the Print queue of your DocuColor is named print_Server, your file is 
named Sample, and you want to print two copies, type:

lpr -Pprint_Server -#2 Sample
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• On a system running Solaris 2 or any System V implementation of UNIX, use the lpr 
command to send a job to the DocuColor as follows:

lpr -d <printername> {-n <-#copies>} <filename>

For example, if the Print queue of your DocuColor is named print_Server, your file is 
named Sample, and you want to print two copies, type:

lpr -d print_Server -n 2 Sample

TO DISPLAY A LIST OF JOBS IN THE QUEUE:

• On a system running SunOS 4 or another BSD-based variant, use the lpq command to 
see printer jobs in the queue as follows:

lpq <-Pprinter>

For example, if the Print queue of your DocuColor is named print_Server, type:

lpq -Pprint_Server

Your workstation displays the contents of the queue.

• On a system running Solaris 2 or any System V implementation of UNIX, use the lpstat 
command to see printer jobs in the queue as follows:

lpstat -o <printername>

For example, if the Print queue of your DocuColor is named print_Server, type:

lpstat -o print_Server

Your workstation displays the contents of the queue.

TO REMOVE JOBS FROM THE QUEUE:

NOTE: Unless you log in as the root user, you can remove only your own jobs. 

• On a system running SunOS 4 or another BSD-based variant, use the lprm command to 
remove jobs from the queue as follows.

lprm <-Pprinter> <job #…>
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You can use the lpq command to check the job number.

For example, to remove job number 123 from the Print queue of your DocuColor 
named print_Server, type:

lprm -Pprint_Server 123

The lprm command reports the names of any files it removes.

• On a system running Solaris 2 or any System V implementation of UNIX, use the cancel 
command to remove jobs from the queue.

cancel <printername> <job ID>

For example, to remove job number 123 from the Print queue of your DocuColor 
named print_Server, type:

cancel print_Server 123
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The following utilities are available to help you manage your print jobs on the 
DocuColor:

• Spooler™, which is installed from the User Software CD, enables you to view the 
order and priority of print jobs, delete jobs, and move jobs between queues. You can 
also use it to view job accounting information.

• Downloader™, which is installed from the User Software CD, enables you to print 
PostScript and Encapsulated PostScript (EPS) files directly to the DocuColor 
without using the application they were created in. Downloader also enables you to 
manage printer fonts on the DocuColor.

NOTE: You cannot use Spooler and Downloader with the parallel port.

• The WebSpooler WebTool, accessible over the Internet or intranet, has the same 
functionality as Spooler.

• The Installer WebTool, accessible over the Internet or intranet, enables you to 
download printer file installers directly from the server.

For more information on the Installer WebTool, see Getting Started.

Spooler
Spooler is a utility that is installed from the User Software CD. Unlike the WebSpooler 
WebTool, which must be accessed via an Internet browser, users need only a network 
connection to the DocuColor in order to use Spooler.

NOTE: Spooler is supported with Windows 95 and Windows NT 4.0 only. Spooler is 
not supported with Macintosh, Windows 3.1x, or Windows NT 3.51.

Access privileges
The DocuColor system allows the site administrator to choose and implement a 
password. This password is required to use the job management features of Spooler.

If you have been given the Spooler password, you can manage job flow and override 
print settings of all jobs. If not, you can still manage job flow and override print 
settings of your own jobs, as well as track the status of all other jobs. Check with your 
site administrator for information on Spooler access privileges.
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TO LAUNCH SPOOLER:

1. Double-click the Spooler icon or choose Spooler from the Windows 95 Start button.

2. Select the DocuColor from the Chooser list and click OK.

The Spooler main window and File, Edit, Window, Help (Windows), and 
Administrator menus appear.

3. To access Administrator functions, choose Password from the Administrator menu.

This menu is active only if a password was created on the DocuColor.

4. Enter the password in the window that appears, and click OK.

Tracking and managing jobs
Spooler lets you monitor and manipulate the print jobs that you send to the 
DocuColor. It also lets system administrators track and manage all users’ print jobs.
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Spooler jobs can be in one of the following queues:

Jobs in the queues are stored on the DocuColor hard disk. Make sure that you leave 
enough space on the hard disk for fonts and other Spooler jobs.

You can use the Spooler Job Log to view information about jobs printed to the 
DocuColor for job accounting purposes, or saved for reference. The Job Log can be 
printed to the DocuColor or saved as a file and viewed in other applications.

Print Normal print jobs sent to the DocuColor appear in the Print 
queue. You can move and manipulate these jobs as described below.

Printed The jobs most recently sent to the DocuColor are saved in the 
Printed queue. You can drag these jobs back to the Print queue to 
print additional copies. The number of jobs saved in the Printed 
queue is set by your system administrator in Setup on the 
DocuColor Control Panel.

Current Print and RIP status

Name of the job currently 
printing

Scroll list of every document sent 
to the Print queue

Jobs with PostScript errors appear 
in Printed queue with Alert icon

Name of the job currently 
processing

Server name or IP address of 
DocuColor

Available space on DocuColor 
hard disk
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The job list includes information about the document name, user name, time and date 
sent, print device, and file size.

The window is split into regions that correspond to the different queues and steps in 
the printing process. You can click and drag a job to the Print region of the window to 
print it.

The icons provide information about the job:

Printing Printing 
icon

The job that is currently printing appears in this 
list; it can be selected and deleted to cancel 
printing.

Waiting Printing 
icon

Jobs that have been processed and are waiting to 
print appear in this list, but they are dimmed 
because their settings cannot be changed and 
they cannot be moved or canceled.

Ripping RIP icon Jobs that are processing appear in this list; they 
can be selected and deleted to cancel processing.

Print Print icon Jobs that have not been processed appear in this 
list, in the order they will be processed and 
printed. The jobs can be selected and deleted to 
cancel processing and printing.

Printed Printed icon Jobs that have been printed are saved in this list. 
Jobs are stored in the Printed queue until the 
limit set by your system administrator in Setup 
on the DocuColor Control Panel is reached. 
The jobs can be selected and deleted from the 
DocuColor hard disk.

Printed Alert icon If a PostScript error occurred while a job was 
printing, it appears in the Printed queue with 
an Alert icon next to it. You can double-click 
the Alert icon to display the error message. The 
jobs can be selected and deleted from the 
DocuColor hard disk.
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Buttons also appear above the scroll list. The buttons are:

TO SET SPOOLER PREFERENCES:

1. Choose Preferences from the Edit menu.

The Preferences dialog box appears.
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You can use this window to specify that the DocuColor:

Update Automatically every n seconds or Update Manually—This option lets you 
specify whether the Spooler main window is automatically updated every 20 seconds 
(or at an interval that you set), or whether it is updated only when you choose the 
Update command from the Window menu. By default, the Spooler main window is 
updated automatically every 20 seconds.

NOTE: When automatic updating is on, data is coming from the DocuColor across the 
network very frequently. This data adds to the network traffic, and may slow down 
other network jobs. For optimum network performance, turn off automatic updating 
in the Spooler Preferences dialog box; when you want to view updated information in 
the Spooler window, choose Update from the Window menu or click the Update 
button.

Confirm file deletion—Select this if you want a confirmation dialog box to appear 
before you delete a file.

2. If you selected Manual updating in the Preferences window, choose Update from the 
Window menu to update the information in the Spooler main window.

Duplicating, copying, moving, and deleting jobs
Users monitor their own print jobs. The DocuColor system administrator (or anyone 
with Spooler Password access) can move, delete, and configure jobs for all users, and 
can re-order jobs within a queue.

Duplicating jobs

You can duplicate jobs in the Print and Printed queues:

• If you want to change printing parameters in the Override Print Settings dialog box 
without losing the original settings.

• If you want to print more than 20 copies to the sorter (the maximum number of 
copies that you can print to the sorter is 20).

When you duplicate a job, the DocuColor creates a reference to the original file, so 
duplicate files do not require the full amount of disk space on the DocuColor. As long 
as one of the duplicates remain, the DocuColor saves the file, so you can delete all but 
one reference to a file.
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TO DUPLICATE A JOB WITHIN A QUEUE: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-click to 
select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent jobs.

2. Choose Duplicate Job(s) from the Edit menu.

The job appears at the bottom of the queue. 

TO DUPLICATE AND PRINT A JOB: 

1. Select the job that you want to copy by clicking its name. 

The selected job is highlighted.If you want to select more than one job, Shift-click to 
select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent jobs.

2. Click the Duplicate and Print button, or drag the job to the Duplicate and Print button.

The job appears at the bottom of the Print queue. 

TO MOVE A JOB WITHIN A QUEUE:

1. Choose Password from the Administrator menu and enter the password.

If there is no password, go to step 2.

2. Select the job that you want to move by clicking its name. 

The selected job is highlighted. If you want to select more than one job, Shift-click to 
select multiple, adjacent jobs; Ctrl-click to select multiple, non-adjacent jobs.

3. Drag the file to the new location in the queue.

TO DELETE A JOB FROM ANY OF THE QUEUES:

1. Select the job that you want to delete by clicking its name.

2. Drag the selected job to the Delete button or click the Delete button.

You can also choose Delete Job(s) from the Edit menu.

System administrators (or anyone with Spooler Password access) can delete any job.
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Changing print settings for a job
You can set certain printing parameters for a job in the Override Print Settings dialog 
box. The settings in this dialog box override the settings in the Printer Specific Options 
(Mac OS)/Options (Windows) dialog box and in Setup on the DocuColor Control 
Panel.

You can change printing parameters only for jobs in the Print and Printed queues of 
the Spooler main window.

System administrators (or anyone with Spooler Password access) can change print 
settings for any job.

TO CHANGE PRINT SETTINGS FOR A JOB:

1. Double-click a job or select the job and choose Override Print Settings from the Edit 
menu.

The Override Print Settings dialog box appears. 

2. Choose the new settings from the pop-up menus.

If you select Default Settings, the job will use the settings in the Printer Specific 
Options (Mac OS)/Options (Windows) dialog box.

For information about these options, see Appendix D, “Setting Job Overrides.”

3. Click OK to make changes.
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Using the Job Log
With Spooler, you can view and print a log of all the jobs printed to the DocuColor. 
You can also save the Job Log as a text file that you can then import into a spreadsheet 
or word processing application for job accounting purposes. All jobs printed to the 
queues, printed by direct connection, and scanned from the copier are listed in the 
Job Log.

TO DISPLAY, PRINT, AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Window menu.

2. Specify the period for the Job Log in the window that appears.

Click All to view all jobs since the Job Log was cleared; click Date if you want to 
specify a period of time for the Job Log.

3. Click OK.

The Job Log window displays a list of all the jobs and the following information about 
them: status, document name, user name, date, start time, end time, process time, file 
size, print device, paper size, media, number of originals, number of color pages, 
number of black and white pages, total number of pages, note 1, and note 2.

The information in the note fields is specified in the Print dialog box if you are using 
the Adobe PostScript printer driver. 
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Use the scroll bar at the bottom of the window to view all fields in the Job Log 
window.

The text in the Status column provides information about the job:

4. To update the Job Log, click the Update button at the top of the window.

5. To print the Job Log, choose Print Job Log from the File menu or click the Print button 
at the top of the window.

The information displayed in the Job Log window prints to the current DocuColor. 
When you print the Job Log, totals are printed for all appropriate columns.

6. To save the Job Log as a file that you can view with a different application, choose 
Export Job Log from the File menu or click the Export button at the top of the window.

7. Enter a name for the log file, and click Save. 

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 
separated by tabs.

OK The job was printed normally.

ERROR A PostScript error occurred while a job was processing. You can 
double-click ERROR to display the error message. A dialog box 
displays the PostScript error. Click OK to close the dialog box.

CANCEL The job was canceled before printing was completed.

Export 

Print 

Update

Delete
Job Log
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8. If you entered the Administrator password, you can choose Delete Job Log from the 
File menu to clear the Job Log. 

The system administrator can also print and clear the Job Log from the Control Panel.

Downloading files and fonts
You can use Downloader to:

• Print PostScript and EPS files

• Check the status of the DocuColor

• Manage the PostScript printer fonts stored on the DocuColor hard disk

NOTE: You can also use standard LaserWriter downloaders, such as the Adobe Font 
Downloader, with the DocuColor. Downloader was designed specifically for the 
DocuColor; you cannot use Downloader with any other printer.

TO VIEW INFORMATION WITH DOWNLOADER:

1. Double-click the Downloader icon or choose Downloader from the Windows 95 Start 
button.

2. Select the DocuColor from the Chooser list and click OK.

Downloader’s Status window appears and you see the Toolbar, Downloader’s menu(s), 
and the status bar at the bottom of the screen.



55-12 Managing Print Jobs
Buttons for some menu functions display in the Toolbar at the top of the window. 
Click the button to perform the function. The buttons are:

The Print Status region displays the server status and the user name and document 
name of the job currently printing.

The RIP Status region displays the server status and the user name and document 
name of the job currently processing. 

Open Click this button to connect to a different 
DocuColor.

Download Click this button to download a file or font to 
the DocuColor.

Display font list Click this button to display a list of printer 
fonts on the DocuColor hard disk.

Display status 
window

Click this button to display the status window 
for the current DocuColor. 

About the 
Downloader

Click this button to view version information 
about Downloader.
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The Download Progress bar dynamically displays the progress of the job as it 
downloads to the DocuColor.

The Hard Disk region displays the amount of available disk space on the DocuColor.

Click the Display Font List button or choose Font List from the File menu to view 
font information.

3. To select a different DocuColor, click the Open button or choose Open from the File 
menu.

4. Select the DocuColor from the Chooser list, and click OK.

5. To close the window, choose Close from the File menu; to close the application choose 
Exit from the File menu.

Printing with Downloader
Printing PostScript files with Downloader is fast—generally faster than printing from 
within applications. If you regularly print large files, be sure to try printing with 
Downloader.

TO DOWNLOAD A FILE OR FONT WITH DOWNLOADER:

1. Use your application to generate a file.

You can save a PostScript file by selecting the PostScript option in the application’s 
Print dialog box. With some applications, you can save EPS files.

If you experience problems printing EPS files with Downloader, you can print the file 
directly from the application in which you created it.

2. Double-click the Downloader icon.
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3. Choose Download from the File menu or click the Download button.

A dialog box containing a list of files appears.

4. Select the file type to display in the Files of type menu.

You can leave this at the default All Known Formats, or select All Files. All Known 
Formats lists all files in formats supported by Downloader; All Files lists all files.

NOTE: You can download files and fonts in the same batch.

5. Select where to download the file or font in the Connection Type pop-up menu.

You can select the Print Queue or Direct Connection. If the connection is not enabled, 
an error message will appear.

6. Select the filename and click Add File(s).

The File name field displays the name of the selected file before you click Add.

You can use the dialog box to move to different drives and directories to select files to 
download.

If you change your mind about a file, select the filename in the Files to be Downloaded 
list and click Remove File(s).
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7. To change attributes of a job, select it and click Options. 

8. Specify the following information in the dialog box and click OK.

Copies—Specify the number of copies you want by entering the number in the 
Copies text box.

Brightness—Change the Brightness setting if a file prints too dark or too light. Select 
85% for a substantially lighter image, 115% for a substantially darker image, or one of 
the options in between. 

NOTE: Some applications, including Adobe Photoshop, provide transfer functions that 
let you specify density settings for an image. If the file you are printing includes 
transfer functions, the Downloader Brightness options will have no effect on your 
printout. For more information on using transfer functions, see the documentation for 
your application.

‘showpage’ after EPS files—In most cases, you do not need to use this option. Select 
the ‘showpage’ option only if an EPS file fails to print without it. This option adds a 
showpage PostScript language command at the end of the print job. Some applications 
omit this necessary PostScript language command when they generate EPS files. Select 
this option when printing EPS files generated by these applications. If you select this 
option unnecessarily, extra blank pages may print.

9. Repeat step 7 and step 8 for any other jobs as needed.

10. When you have selected all files and fonts, click Download File(s).

11. To cancel downloading, press Escape.



55-16 Managing Print Jobs
Downloading and managing printer fonts 
The DocuColor includes 136 PostScript fonts; for a complete list, see Appendix B, 
“Font List.” In addition, two Adobe Multiple Master fonts are included and are used 
for font substitution in PDF files.

Before printing a PostScript or EPS file containing fonts that are not resident on the 
DocuColor hard disk, you must download the fonts manually. 

You cannot use Downloader to download TrueType fonts.

Printer fonts and Macintosh screen fonts 

Like all PostScript fonts, the fonts included with the DocuColor come in two forms: 
printer fonts and screen fonts. The printer fonts are installed permanently on the 
DocuColor’s hard disk. The screen fonts, which are included with the DocuColor, 
should be installed on Macintosh computers. If you are using these fonts in documents 
you print on a LaserWriter, they are probably already installed. If not, you’ll need to 
install them yourself. See Getting Started for instructions.

Occasionally, you may want to use PostScript (Macintosh) or Adobe Type 1 
(Windows) fonts that are not included with the DocuColor. If so, you’ll need to install 
both the screen fonts and the printer fonts on your computer. To do this, follow the 
instructions from the font manufacturer. 

Downloading printer fonts to the DocuColor 

In general, each time you print from within a Macintosh application, the application 
automatically downloads any fonts used in your document that are not already 
installed on the DocuColor, as long as the printer fonts are installed in your System 
Folder. These fonts remain in the DocuColor only until your document has printed. If 
you print the same document again, your application must download the fonts again.

If you regularly use one or more fonts from Macintosh or Windows applications that 
are not already installed in the DocuColor, you can save time by downloading them to 
the DocuColor’s hard disk with Downloader. Fonts you download to the DocuColor’s 
hard disk remain installed until you remove them using Downloader, no matter how 
many times the DocuColor is turned off and on. You’ll probably want to download 
fonts you use on a regular basis to the DocuColor’s hard disk. 
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Before you print PostScript or EPS files using Downloader, make sure that all fonts 
included in your file are installed in the DocuColor. If your file contains fonts that are 
not installed on the DocuColor, the text in these fonts will not print correctly and may 
not print at all. With some applications, you can include fonts when you create 
PostScript files. See your application software for information.

TO VIEW FONT INFORMATION:

1. Choose Font List from the File menu or click the Font List button.

The Font List window appears with buttons in the title bar. The buttons are:

2. Click the Update button to update the information in the list.

3. Click the Print Font List button to print the font list. 

4. Select a font and click the Delete button to delete the font.

Shift-click to select multiple fonts.

NOTE: The printer fonts included with the DocuColor (resident fonts) are locked. 
Locked fonts appear with a lock icon next to the name and cannot be deleted.

Update Click this button to update the information in the font list 
window.

Print Click this button to print the font list to the Print queue.

Delete Select a font and click this button to delete it.
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WebSpooler WebTool
The WebSpooler WebTool is a utility that resides on the DocuColor but can be 
accessed over the network from a variety of platforms. The DocuColor functions as an 
Internet or intranet server, and has a home page that lets remote users view server 
functions and manipulate jobs.

WebSpooler can be used on Windows 95, Windows NT 4.0, and Macintosh client 
computers with certain Internet browsers that support the Java language. For specific 
information on the browsers supported for the WebTools, see Getting Started.

Access privileges
The DocuColor system allows the site administrator to choose and implement a 
password. This password is required to use the job management features of 
WebSpooler.

If you have been given the WebSpooler password, you can manage job flow and 
override print settings of your jobs. If not, you can still track the status of your jobs as 
a Guest. Check with your site administrator for information on WebSpooler access 
privileges.

Starting WebSpooler
To use WebSpooler via the Internet or your site’s intranet, you need the IP address or 
DNS name of the DocuColor. The DocuColor has its own home page, from which 
you are able to select various functions.

TO START WEBSPOOLER:

1. Start up your Internet browser application. 

2. Enter the IP address or the DNS name of the DocuColor.

Check with the administrator for this information.

The DocuColor home page appears.
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3. Click the WebSpooler button at the left to select it.

The Spooler main window and File, Edit, Window, Help, and Administrator menus 
appear.

You can click the question mark next to the WebSpooler button to display information 
about WebSpooler.

NOTE: The Installer WebTool enables you to download printer file installers directly 
from the server. For more information on the Installer WebTool, see Getting Started.

For complete information on using the WebSpooler WebTool, see “Tracking and 
managing jobs” on page 5-2.
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When an error interferes with printing, you will see a message on the DocuColor 
Control Panel. Following are the messages (listed in alphabetical order), with the 
appropriate corrective action for each one.

Message Corrective action/additional information

Accessory disabled The print job calls for a copier accessory (such as a sorter), 
which is either disabled or not available.

Busy (Copier) The DocuColor has received a print job, but the copier is 
busy copying or performing a non-printing related task. 
The job will print when the copier finishes that task.

Check power & cable There is a problem with the copier power or cable 
connection. First check to make sure that the copier is 
turned on. There may also be a problem with the cable 
connection between the DocuColor and the copier. Make 
sure that the cable has not come loose. The DocuColor 
will resume printing when the cable is securely connected 
to both the DocuColor and the copier.

Copier needs attn There is an unidentified problem with the copier. See the 
copier user interface for additional messages. The copier 
will resume printing when the problem is corrected.

Copier offline Someone has selected Suspend Printing from the Functions 
menu on the DocuColor Control Panel. When you select 
Resume Printing at the Control Panel, printing will resume 
normally.

Copier running The copier is scanning or making a copy.

Door open One of the copier doors is open. Printing will resume 
when the door is closed.

Fuser web empty The copier’s fuser web is empty, and needs replenishing. 
Contact your authorized service technician.

Ld ___ in bypass The copier’s bypass tray is not loaded with the paper size 
or type specified. The DocuColor will print when the 
bypass tray is loaded with the required paper.

Appendix A: 
Error Messages
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Ld ___ in tray 1 The copier’s Tray 1 is not loaded with the paper size or 
type specified. The DocuColor will print when Tray 1 is 
loaded with the required paper.

Ld ___ in tray 2 The copier’s Tray 2 is not loaded with the paper size or 
type specified. The DocuColor will print when Tray 2 is 
loaded with the required paper.

Ld ___ in tray 3 The copier’s Tray 3 is not loaded with the paper size or 
type specified. The DocuColor will print when Tray 3 is 
loaded with the required paper.

Ld ___ in tray 4 The copier’s Tray 4 is not loaded with the paper size or 
type specified. The DocuColor will print when Tray 4 is 
loaded with the required paper.

Ld ___ paper The copier is not loaded with the paper size specified in 
the application. The DocuColor will print when the 
copier is loaded with the required paper. This message will 
also appear if you are printing transparency interleave and 
do not have the correct paper size loaded.

Ld ___ trans bypass The copier’s bypass tray is not loaded with the 
transparency size specified. The DocuColor will print 
when the bypass tray is loaded with the required 
transparency.

No toner The toner for one of the C, M, Y, or K colors has run out. 
Refer to the copier display to determine which toner color 
is empty. If more than one toner needs to be added, press 
and hold the Stop icon on the copier for additional 
information.

Paper jam There is a paper jam in the copier. Open the copier doors 
and check the locations indicated on the copier display. 
The DocuColor will resume printing when you have 
cleared the paper jam and closed the copier doors.

Press “Clear All” Press the Copier Clear All button on the copier.
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Remove copies from sorter The maximum page capacity for one of the sorter bins has 
been exceeded. Printing will resume when the sorter is 
cleared.

Replace waste bottle The copier’s waste toner container is full of used toner. 
Replace the container with a new one according to the 
instructions in your copier manual. The DocuColor will 
resume printing when you have replaced the waste toner 
container.

Reset copier & server The DocuColor and the copier must be power cycled. 
First turn off the copier and the DocuColor; then turn on 
the copier. When the copier is ready, turn on the 
DocuColor.

Sorter limit exceeded The sorter output bin is full. Printing will resume when 
the sorter output bin is cleared.

Sorter problem There is an unknown problem with the sorter unit on the 
copier. See the copier user interface for more information.

Unknown error An error occurred with the copier. See the copier user 
interface for more information.

Warming Up The copier is powering up. It will be ready for printing in 
a few minutes.
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This appendix lists the built-in printer fonts included with your DocuColor.

PostScript printer fonts
Listed below are the 136 built-in PostScript printer fonts on the DocuColor.

In addition to the fonts listed below, two Adobe Multiple Master fonts are included 
and are used for font substitution in PDF files.

NOTE: For Mac OS computers, install the corresponding screen fonts from the User 
Software CD. For instructions, see Getting Started.

Adobe Type 1 fonts
The DocuColor includes 117 Adobe Type 1 fonts:

• AlbertusMT, AlbertusMT-Italic, AlbertusMT-Light

• AntiqueOlive-Roman, AntiqueOlive-Bold, AntiqueOlive-Compact, 
AntiqueOlive-Italic

• AvantGarde-Book, AvantGarde-BookOblique, AvantGarde-Demi, 
AvantGarde-DemiOblique

• Bodoni, Bodoni-Bold, Bodoni-Italic, Bodoni-BoldItalic, Bodoni-Poster, 
Bodoni-PosterCompressed

• Bookman-Demi, Bookman-DemiItalic, Bookman-Light, Bookman-LightItalic

• Carta

• Clarendon, Clarendon-Bold, Clarendon-Light

• CooperBlack, CooperBlack-Italic

• Copperplate-ThirtyThreeBC, Copperplate-ThirtyTwoBC

• Coronet-Regular

• Courier, Courier-Bold, Courier-Oblique, Courier-BoldOblique

• Eurostile, Eurostile-Bold, Eurostile-ExtendedTwo, Eurostile-BoldExtendedTwo

• GillSans, GillSans-Bold, GillSans-Italic, GillSans-BoldItalic, GillSans-Condensed, 
GillSans-BoldCondensed, GillSans-Light, GillSans-LightItalic, GillSans-ExtraBold

• Goudy, Goudy-Bold, Goudy-Italic, Goudy-BoldItalic, Goudy-ExtraBold
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• Helvetica, Helvetica-Bold, Helvetica-BoldOblique, Helvetica-Condensed, 
Helvetica-Condensed-Bold, Helvetica-Condensed-BoldObl, 
Helvetica-Condensed-Oblique, Helvetica-Narrow, Helvetica-Narrow-Bold, 
Helvetica-Narrow-BoldOblique, Helvetica-Narrow-Oblique, Helvetica-Oblique

• JoannaMT, JoannaMT-Bold, JoannaMT-Italic, JoannaMT-BoldItalic

• LetterGothic, LetterGothic-Bold, LetterGothic-BoldSlanted, LetterGothic-Slanted

• LubalinGraph-Book, LubalinGraph-BookOblique, LubalinGraph-Demi, 
LubalinGraph-DemiOblique

• Marigold

• MonaLisa-Recut

• NewCenturySchlbk-Roman, NewCenturySchlbk-Bold, NewCenturySchlbk-Italic, 
NewCenturySchlbk-BoldItalic

• Optima, Optima-Bold, Optima-Italic, Optima-BoldItalic

• Oxford

• Palatino-Roman, Palatino-Bold, Palatino-Italic, Palatino-BoldItalic 

• StempelGaramond-Roman, StempelGaramond-Bold, StempelGaramond-Italic, 
StempelGaramond-BoldItalic

• Symbol

• Tekton

• Times-Roman, Times-Bold, Times-Italic, Times-BoldItalic

• Univers, Univers-Bold, Univers-BoldExt, Univers-BoldExtObl, 
Univers-BoldOblique, Univers-Condensed, Univers-CondensedBold, 
Univers-CondensedBoldOblique, Univers-CondensedOblique, Univers-Extended, 
Univers-ExtendedObl, Univers-Light, Univers-LightOblique, Univers-Oblique

• ZapfChancery-MediumItalic

• ZapfDingbats



BB-3 Font List
TrueType fonts
The DocuColor includes 19 TrueType fonts:

• Apple-Chancery

• ArialMT, Arial-BoldMT, Arial-ItalicMT, Arial-BoldItalicMT

• Chicago

• Geneva

• HoeflerText-Regular, HoeflerText-Black, HoeflerText-Italic, HoeflerText-BlackItalic, 
HoeflerText-Ornaments

• Monaco

• NewYork

• TimesNewRomanPSMT, TimesNewRomanPS-BoldMT, 
TimesNewRomanPS-ItalicMT, TimesNewRomanPS-BoldItalicMT

• Wingdings-Regular
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This section provides some troubleshooting guidelines should a problem arise. If you 
are still unable to resolve a problem, contact your authorized service/support center. 

Basic troubleshooting tips
There are some basic situations that can cause a variety of problems. Before you look 
for a specific problem, use the tips in this list.

1. Check the power and cables for your DocuColor, copier, and computer.

2. Check the Control Panel and Activity Light of the DocuColor for information.

3. If possible, print the Configuration page from the Control Panel and make sure that 
the settings match your configuration.

4. Check the current status of the DocuColor.

The current status appears on the DocuColor control panel. Press the Menu button to 
see other status screens. For example, if there is a job processing and one printing, you 
can press the Menu button to view status information about both jobs.

In Downloader, check the Status window, or look at the Status field in the Spooler 
main window. If the DocuColor is processing your job, you’ll see this from the status 
message. If your print job doesn’t appear in the status message, another user’s job may 
be printing before yours, or the DocuColor may already have finished printing your 
job. If the Printed queue on your DocuColor is enabled, jobs that have finished 
printing will appear in that list in the Spooler main window. If your job is waiting to 
print, it will appear in the list for the Print queue.

If you are printing over an IPX (Novell) network, the job may be processing on the 
Novell print server before it is sent to the DocuColor.

5. Open the Spooler main window and locate the name of the job you are trying to print. 

This window provides information about the status of every job printed to a queue, 
including information about jobs that do not print because of PostScript errors.

Appendix C: 
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General printing problems

If this happens: Try this:

The DocuColor doesn’t 
appear in the Macintosh 
Chooser list of printers

1. On the Macintosh, make sure that the correct zone is selected and that AppleTalk is 
active.

AppleTalk must be active. The DocuColor may be in a different zone from the one 
that’s selected. (If your network doesn’t have zones, this is not applicable.) Print the 
Configuration page from the Control Panel to view the correct AppleTalk zone.

2. Does the DocuColor appear in the Chooser on another Macintosh on the same network?

If another Macintosh computer is nearby, check to see if the DocuColor appears in the 
Chooser on that Macintosh. If the DocuColor is visible from one Macintosh computer, 
but not from another, there may be a problem with the way the second Macintosh 
computer is connected to the network. Check all the cabling and other connections, 
and verify that the network is properly terminated. If there is a 10BaseT transceiver on 
the network, make sure that its green link integrity light is on. For more information 
about the network, refer to the documentation provided with the network hardware. 

3. Do other printers on the network appear in the Chooser?

If your network includes printers other than the DocuColor, they should appear in the 
Chooser. If none of the printers appear in the Chooser list, there is most likely a 
problem with the way the Macintosh computer is connected to the network. Check all 
the cabling and other connections. For more information about the network, refer to 
the documentation provided with the network hardware.

If other printers appear in the Chooser, there may be a problem with the DocuColor 
connection. Contact your DocuColor system administrator.

4. Try printing a test page by pressing the Menu button and choosing Print Pages/Test Page 
from the Control Panel.

If you’re able to print the test page, but DocuColor still does not appear in the Chooser, 
contact your authorized service/support center. 

You cannot connect to a 
DocuColor from a utility 
chooser

• Make sure that no one is calibrating the DocuColor.

If someone is running AutoCal on the DocuColor, you can select it in the Chooser, but 
you cannot connect to it. This insures that only one person is calibrating the server at 
any time and that print jobs do not use unexpected calibration.

You cannot open the 
DocuColor with the Chooser 
in a Windows utility

• Is your NET_WSCK.INI file set up correctly?

This file must be set up for Windows 95 and Windows NT printing with TCP/IP or 
IPX/SPX. See Getting Started for instructions.
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Printing seems to take too 
long

• Print to the Print queue instead of to the direct connection.

When you print to the Print queue, the job is stored on the DocuColor until it can be 
processed and printed; when you print to the direct connection, some file processing is 
performed on your computer before it is sent to the DocuColor and it cannot begin 
processing on the DocuColor until it is done processing the previous job, so you must 
wait longer to use your computer.

Special paper or transparency 
options are grayed out

• Select a tray that supports printing special paper or transparencies such as the Bypass 
Tray.

DocuColor doesn’t respond to 
a Print command

• Has someone disconnected the copier by selecting Suspend Printing?

If the DocuColor system administrator or another user has selected Suspend Printing on 
the DocuColor Control Panel to interrupt printing (so that someone can make a color 
copy, for example), your print job will not resume until someone selects Resume Printing 
from the Functions menu on the Control Panel.

• Did you select the DocuColor as the current printer?

Before printing, you must select the DocuColor as the current printer from your 
Mac OS computer, Windows computer, or UNIX workstation.

• Is the DocuColor visible in the Chooser on your Macintosh computer?

If not, see the topic, “The DocuColor doesn’t appear in the Macintosh Chooser list of 
printers” on page C-2.”

• Make sure that the copier is switched on.

Someone may have turned the copier off, or the Automatic Power-Off or Power Saver 
mode function may have engaged. Even with the copier off, the DocuColor appears in 
the Chooser as long as the DocuColor itself is turned on. 

• Try printing a test page by pressing the Menu button and choosing Print Pages/Test Page.

If you’re able to print the test page but still can’t print a file from your computer, contact 
your system administrator or your authorized service/support center.

• If you are printing over an IPX (Novell) network, verify through PCONSOLE that the job 
was sent to the Novell queue and that the queue is being used by the DocuColor.

• Make sure that the job does not contain a PostScript error.

In Setup, turn on the Print up to PostScript error option to search for PostScript errors 
in the file. In Spooler, check to see if the job has an error icon next to it. Double-click 
the icon to see the PostScript error message.

If this happens: Try this:
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Message requests a paper size 
that you don’t have

• Cancel the job and do one of the following:

If you are printing a PostScript file, set the Convert Paper Sizes setting in Printer Setup 
on the Control Panel to convert the job to the paper size you do have. You can do this to 
convert between US and metric paper sizes. See the Administrator Guide for 
information.

If you are printing a file from an application, change the page size in the Page Setup 
dialog box.

Test page or other special 
Control Panel page doesn’t 
print

1. If the message “Ripping” displays on the Control Panel, but the page never prints, 
restart the DocuColor, press the Menu button to enter Setup, and verify that the Printer 
Model in Printer Setup is specified correctly.

2. Check the copier’s display.

If the copier display says Ready to copy, proceed to step 3.

If the display shows a diagnostic or error message, take the appropriate corrective action, 
as described in the copier manual.

3. Try making a copy.

If you can make a copy, proceed to step 4.

4. Restart the DocuColor, and when you see Idle on the status line of the DocuColor 
display, try printing a test page again. 

If the test page still fails to print, contact your authorized service/support center.

Jobs sent to the parallel port 
do not print

• Increase the parallel “Port Timeout in Seconds” on the DocuColor Control Panel. 

• On the DocuColor Control Panel, change the Ignore EOF Character setting.

If you are printing ASCII format PostScript only, set Ignore EOF Character to No.

If you are printing Binary format PostScript, set it to Yes.

• If you print using the DOS copy command, make sure to use the /b option when printing 
binary files.

• Restart your Windows computer, enter BIOS setup, and if you have a BIOS setting for the 
parallel port, make sure that it is set to Compatible mode and not to Bi-Directional, ECP, 
EPP, or any other mode.

If this happens: Try this:



CC-5 Troubleshooting
Problems with print quality

Jobs sent to the parallel port 
do not print (cont’d.)

• If the PostScript Printer Driver that you are using lets you select bi-directional 
communication, make sure that it is disabled. 

This is generally set from the Properties dialog box for the printer.

• If you are printing from a DOS window with Windows 95, display the Properties dialog 
box for the printer, click the Details tab, and then click Port Settings. In the Configure 
LPT port box that displays, turn the “Spool MS-DOS print jobs” option off. 

If this happens: Try this:

Print settings for your job 
output do not match the 
settings you gave

• Make sure that you did not override the setting for the job in another place.

For information about options and overrides, see Appendix D, “Setting Job Overrides.”

You get poor printing results • Does your application require the DocuColor’s printer description files?

If you are printing from an application such as Adobe Separator or PageMaker, 
MacroMedia FreeHand, or QuarkXPress, you should make sure that the DocuColor 
printer description file is installed correctly. For information about installing these files, 
see Getting Started.

• Calibrate your copier using AutoCal.

Separations do not combine 
properly

• Make sure that the file was initially created as separations.

• If you are printing separations or a DCS format file, check the Combine Separations 
setting for the job in the Printer Specific Options (Macintosh)/Options (Windows) 
dialog box.

With Combine Separations On, all four colors will be printed on a single page; with 
Combine Separations Off, four black-and white pages will print to simulate four single-
color plates.

The registration or colors of an 
image are not what you 
expected

• Print a test page or make a test copy with the copier.

The problem may be with the copier. If your test page or copy show that the copier is 
working properly, correct the problem within your application software. If the test page 
or copy are wrong, your copier may need to be calibrated or adjusted in some other way. 

If this happens: Try this:
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Problems with the utilities

Your printed file appears too 
dark

• Adjust the image’s Brightness setting in the Printer Specific Options (Macintosh)/
Options (Windows), Download (Downloader), or Override Print Settings (Spooler) dialog 
box.

You can use the Brightness options in Downloader to adjust the lightness of your image 
whenever you print a PostScript or Encapsulated PostScript (EPS) file. 

Color file prints in black and 
white

• In the Printer Specific Options (Macintosh)/Options (Windows) dialog box, make sure 
that you have not selected Black and White.

• Make sure that the Color Mode selected for the job in the Printer Specific Options 
(Mac OS)/Options (Windows) dialog box is CMYK and not Grayscale.

Desktop Color Separations 
(DCS) format images print 
incorrectly

1. Make sure that you selected the correct options to send separations in the application’s 
Print dialog box.

2. Make sure that you have the file for every layer of separation that you are printing.

3. Set the Combine Separations option to On in the Printer Specific Options (Macintosh)/
Options (Windows) dialog box.

This combines the high-resolution files for an image and prints them. With Combine 
Separations Off, the low-resolution master file will print.

General problem with: Try this:

Downloader and Spooler 
utilities

• Make sure that you are using the latest version of the utilities.

When you update your DocuColor to new system software, you should delete the 
utilities on your Macintosh or Windows computer and install the latest utilities to 
insure full compatibility.

• Make sure that either the NET_WIPX.DLL or NET_WSCK.DLL file is in the 
WINDOWS\SYSTEM directory.

• Make sure that only one file is installed in this directory and that it is the correct file for 
your system. 

If this happens: Try this:
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Downloader problems

If his happens: Try this:

You can’t print an EPS file 
using Downloader

• Try printing using the “Showpage” option in the Download PostScript File dialog box.

The Showpage (after EPS file) option adds a “showpage” PostScript language command 
at the end of the print job. Certain applications omit this necessary PostScript language 
command when they generate EPS files. You’ll need to select the Append Showpage 
option when printing EPS files generated by these applications.

If you continue having difficulties printing an EPS file with the DocuColor 
Downloader, try printing the file from the application in which it was created.

• Try printing the EPS file on the media in the bypass tray.

• Make sure that the job does not contain a PostScript error.

In Setup, turn on the Print up to PostScript error option to search for PostScript errors 
in the file.

In Spooler, check to see if the job has an error icon next to it. Double-click the icon to 
see the PostScript error message.

You have problems 
downloading a font with 
Downloader

• Make sure that the Direct connection is enabled on the DocuColor Control Panel.

You can print the Configuration page from the Control Panel to see which connections 
are enabled.

Extra blank page prints after a 
Downloader job

• Turn off the “Showpage” option.

This option adds a special PostScript command that will cause an extra blank page to 
print if it is not needed.
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Job Override settings enable you to use all the special features of your copier and 
DocuColor. You can set job settings in several places. This table shows where options 
can be set and where they can be overriden. The underlined option in the leftmost 
column is the printer’s default. The settings to the right override one another in the 
order given.

For example, Spooler settings override Downloader settings, Downloader settings 
override Print dialog box settings, and so on.

To change settings on the DocuColor Control Panel, restart the DocuColor and 
choose Run Setup. For detailed instructions, see the Administrator Guide.

Where to set print options
For information about current settings on the DocuColor, choose 
Print Pages>Configuration from the Functions menu on the Control Panel. The 
Configuration page lists all current settings.

You can also set and override some options from the Print dialog box and other dialog 
boxes. The options are the same regardless of the name of the dialog box. To set 
options in the Print and Printer Specific Options (Macintosh), or Options/Features 
(Windows) dialog boxes, open the file in an application and follow the instructions in 
Chapter 2, “Printing with Macintosh Computers” and Chapter 3, “Printing with 
Windows Computers”.

To change options in Downloader, select the job in the Files to be Downloaded list and 
click Options to display the Options dialog box. For more information, see “Printing 
with Downloader” on page 5-13.

To change options in Spooler, select the job and double-click to display the Override 
Print Settings dialog box. For more information, see “Changing print settings for a 
job” on page 5-8.

Appendix D: 
Setting Job 
Overrides
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Setting and options
(Underlined option is 

printer’s default)
Description Control 

Panel
Print 

dialog box

Printer 
Specific 
Options 

Downloader 
Options

Spooler 
Overrides

Brightness
85% Lightest/
90% Lighter/
95% Light/
100% Normal/
105% Dark/
110% Darker/
115% Darkest

Select 85% for a substan-
tially lighter image, 115% 
for a substantially darker 
image, or one of the 
options in between.

No No Yes Yes Yes

Color Mode
CMYK/Grayscale

Specify the color mode 
for the current print job.
Select CMYK for a 
full-color document.
Select Grayscale for a 
grayscale or black and 
white document.

No No Yes No No

Copier Mode
Photo/Map

Select Photo if the file is 
a photograph.
Select Map if the file con-
tains detailed drawings 
and small text, such as 
might be found on a map.

No No Yes No No

Copies Specify the number of 
copies of the job to print.

No Yes No Yes Yes

Document Set
Off/On

For more information, see 
page D-3.

Specify whether or not to 
reverse order print and 
collate multiple-page/
multiple-copy jobs.

No No Yes No Yes
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Document Set
The Document Set option enables you to reverse order print and collate multiple page/
multiple copy jobs sent from applications that do not support reverse order printing 
and collation.

Media Type
Plain Paper/
Thick Paper/
Transparency/
Interleaved/
Coated Paper/
Thick Paper 2/
Tacking Film/
SST/
Labels

For more information, see 
page D-4.

Specify the type of media 
to use for the job.

No No Yes No Yes

Rendering Style
Photographic/
Presentation/
Solid Color

For more information, see 
page D-5.

Specify a default color 
rendering dictionary 
(CRD) to be used when 
you print RGB images, 
objects, and text. 

Yes No Yes No Yes

Sorter Mode
Off/Sort

For more information, see 
page D-5.

Specify how to output 
multiple-page/multiple-
copy jobs.

No No Yes No Yes

Setting and options
(Underlined option is 

printer’s default)
Description Control 

Panel
Print 

dialog box

Printer 
Specific 
Options 

Downloader 
Options

Spooler 
Overrides
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NOTE: If you print from an application that does support reverse order printing and/or 
collation, make sure to disable these options from within the application before using 
the Document Set option. Enabling reverse order printing and/or collation from 
within an application and setting the Document Set option to On may produce 
unexpected results.

Off—Pages of the job are output from first to last, with all copies of the same page 
grouped together.

On—Pages of the job are output from last to first, with each copy of an entire set 
collated in page order.

Media Type
The Media Type option allows you to select the type of media for loading into the 
manual feed tray.

Plain Paper—Standard bond paper from 16 lb to 28 lb (60 g/m2 to 105 g/m2).

Thick Paper—Paper heavier than 28 lb, up to 90 lb Index (163 g/m2).

Transparency—Transparency sheets.

Interleaved—Multiple transparency sheets inserted with blank, plain paper separators.

With Interleaved selected, the transparencies are fed from the bypass tray and the paper 
separators are fed from the paper tray.

Coated Paper—Special paper with binders, adhesives, and/or pigments applied to the 
paper’s surface on one or both sides.

Select this setting for coated paper from 32 lb to 60 lb Cover (120 g/m2 to 162 g/m2). 
The paper must be fed through the manual feed tray with the grain perpendicular to 
the lead edge of the sheet.

Thick Paper 2—Any paper heavier than 90 lb index.

This setting should also be selected for coated paper greater than 60 lb up to 
80 lb Cover (215 g/m2).

Tacking Film—(Also known as Adhesive Drafting film) Special paper used to make 
corrections to vellum type drawings.

SST (Single-Step Transfer)—Special paper used to transfer full-color images directly 
from copies or prints onto fabric or other types of materials.

Labels—Adhesive-backed, pressure-sensitive label stock.
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Rendering Style
Use this option to select a default color rendering dictionary (CRD) to be used when 
you print RGB images, objects, and text.

Photographic—Optimizes the range of colors on the DocuColor to produce the best 
results for photographic or bitmapped images.

Presentation—Optimizes the output of pure, saturated colors such as those used in 
business presentations.

Solid Color—Most useful for printing spot colors such as those found in company 
logos or corporate charts and graphs.

Sorter Mode
Off—Disables the sorter.

Sort—Copies of a complete job are sorted and output into one of 20 bins, arranged in 
page order.

Sorter specifications

The sorter unit has one top output tray and 20 output bins; therefore, the maximum 
number of copies that can be sorted is 20. Sending 21 or more copies to the sorter 
results in the excess copies of the job being discarded. In order to print more than 20 
copies you can resend the job, 20 copies at a time, from the Print dialog box, from the 
Spooler utility, or from the WebSpooler WebTool.

The maximum capacities of the top output tray and output bins are shown in the table 
below. If a print job exceeds the maximum capacity of a particular tray or bin, the 
DocuColor prints to the maximum capacity and then reports an error message. Once 
the paper is removed, the job resumes printing.

Output bin Paper size Plain paper Thick paper

Top output tray All sizes 250 250

Sort 
(bins 1 to 20)

Letter/A4
LetterR/A4R

50 25

Legal
11 x 17/A3

25 15
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